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1. Importan

1. Important

Acest ghid de utilizare electronic este destinat
tuturor persoanelor care utilizeaza monitorul

Philips. Cititi cu atentie acest manual de utilizare,

fnainte de a utiliza monitorul. Acesta contine
informatii si note importante referitoare la
functionarea monitorului.

Garantia Philips se aplica daca produsul este
manevrat corespunzdtor si utilizat in scopul

pentru care a fost proiectat, in conformitate cu
instructiunile de operare si dacd este prezentatd

factura sau chitanta in original, care sa ateste
data achizitiei, numele distribuitorului, numarul
produsului si numdrul de model.

1.1 Masuri de siguranta si intretinere

) Avertismente

Utilizarea de dispozitive de control, reglari

sau proceduri, altele decat cele specificate in
acest document, poate produce scurtcircuite,
defectiuni electrice si/sau defectiuni mecanice.
Cititi si respectati aceste instructiuni la
conectarea si utilizarea monitorului pentru
computer:

Mod de operare

*  Nu expuneti monitorul la lumina solara
directd, surse de lumind puternica sau la

actiunea unor surse de incdlzire. Expunerea

ndelungata la acest tip de mediu poate
avea drept rezultat decolorarea si
deteriorarea monitorului.

* Este necesard indepartarea obiectelor ce
ar putea cadea In orificile de ventilatie,

precum si a celor care pot impiedica rdcirea

componentelor monitorului.

* A nu se bloca orificiile de ventilatie ale
carcasei.

*  Se va asigura un acces facil la stecher si la
priza de curent, In momentul pozitionarii
monitorului.

« In cazul inchiderii monitorului prin
debransarea cablului de alimentare de la
sursa de curent alternativ sau continuu, se
va astepta 6 secunde anterior recuplarii
acestuia, pentru o functionare normala a
monitorului.

A se utiliza numai cablul de alimentare
corespunzator, furnizat, de fiecare datd,

de catre Philips. Dacd lipseste cablul de
alimentare, se va contacta centrul de service
local. (Vd rugdm sd va adresati Centrului de
Informatii si Asistentd Clienti)

Nu supuneti monitorul la vibratii mari sau la
socuri puternice pe parcursul manevrarii.

A nu se lovi sau scapa monitorul in timpul
functiondrii sau transportului.

Intretinere

Pentru a vd proteja monitorul de posibile
deteriordri, nu supuneti ecranul LCD

la presiuni mari. Atunci cand deplasati
monitorul, apucati-l de rama. Nu ridicati
monitorul plasand palma sau degetele pe
ecranul LCD.

In cazul in care monitorul nu va fi utilizat o
perioada Indelungatd, acesta se va debransa
de la sursa.

Daca este necesar, monitorul se va curata
cu o carpd umeda dupa debransare. Ecranul
poate fi sters cu o carpd uscatd, cand nu
este sub tensiune. Totusi, pentru curdtarea
monitorului, nu se vor folosi niciodata
solventi organici, precum alcool sau solutii
pe bazd de amoniac.

Pentru a se evita riscul aparitiei suprasarcinii
electrice si deteriordrii permanente a

monitorului, acesta nu se va expune la praf,
ploaie, apa sau medii cu umezeald excesiva.

Daca monitorul este expus la umezeald, va
fi sters cu o carpa umeda, cat mai curand
posibil.

Dacd n monitor patrund substante strdine
sau apa, se va intrerupe imediat sursa de
alimentare si se va debransa cablul de

la priza. Apoi, se va extrage substanta
respectivd, urmand ca monitorul sa fie trimis
la centrul de service.

Nu depozitati s utilizati monitorul in locuri
expuse la caldurd, la lumina directa a
soarelui sau la frig excesiv.

Pentru pastrarea functiondrii optime a
monitorului si prelungirea duratei sale de
viatd, acesta va fi plasat Intr-un spatiu ai cdrui
parametri de temperaturd si umiditate se
situeazd in urmdtoarea gama de valori:



*  Temperatura: 0-40°C 32-95°F
*  Umiditate: 20-80% RH

* IMPORTANT: Activati intotdeauna un
economizor ecran cu miscare cand
ldsati monitorul nesupravegheat. Activati
intotdeauna o aplicatie periodica de
improspdtare a ecranului atunci cand
monitorul va afisa un continut static.
Afisarea nelntreruptd a imaginilor statice
o perioada lunga poate produce ,imagini
arse”, cunoscute si ca ,,imagini persistente”

sau ,,imagini fantoma” pe ecranul dvs.

,Imaginea arsd”, ,imaginea persistentd” sau
,imaginea fantomd” reprezinta un fenomen
binecunoscut in tehnologia ecranelor LCD.
Tn majoritatea cazurilor; , imaginea ars3”
sau ,,imaginea persistentd” sau ,imaginea
fantomad” vor dispdrea treptat intr-un
interval de timp dupd deconectarea de la

alimentarea cu energie electrica.

) Avertisment

Simptomele grave de ,,imagine arsd”, ,imagine
persistentd” sau ,,imagine fantoma” nu vor
disparea si nu pot fi reparate. Deteriorarea
mentionatd mai sus nu este acoperitd de
garantie.

Service

* Carcasa trebuie desfacuta numai de catre
personalul calificat din service.

* Daca este necesar un document pentru
reparatie sau integrare, se va contacta
centrul de service local. (vezi paragraful
., Centrul de Informatii pentru Clienti")

* Pentru informatii referitoare la transport,
consultati rubrica , Specificatii tehnice”.

* Anu se lasa monitorul in masind/portbagaj,
sub actiunea directa a razelor solare.

6 Noti

Tn cazul in care monitorul nu functioneazi

normal sau dacd nu stiti cum sd procedati dupa

ce ati aplicat instructiunile din acest manual,
consultati un specialist in service.

1.2 Descrieri ale notatiilor

Urmatoarele subcapitole descriu conventiile de
notatie utilizate n acest document.

Observatii, atentionari si avertismente
Fragmente de text din acest ghid sunt nsotite
de pictograme si pot apdrea cu caractere

aldine sau italice. Fragmentele respective contin
observatii, atentiondri sau avertismente. Acestea
sunt utilizate dupd cum urmeaza:

& Noti

Aceastd pictograma indica informatii si sfaturi
importante care vad pot ajuta sa utilizati mai
eficient computerul.

O Atentie

Aceastd pictograma indicd informatii despre
modalitati de evitare a eventualelor defectiuni
ale hardware-ului si a pierderii de date.

) Avertisment

Aceasta pictograma indicd riscul potential de
vdtdmare corporald si prezintd modalitati de
evitare a problemei.

Anumite avertismente pot aparea in diferite
formate si este posibil sd nu fie insotite de
pictograme. In aceste situatii, prezentarea
specificd a avertismentului este impusd de
autoritatea de reglementare legala.



1.3 Eliminarea produsului si a
ambalajelor aferente

Deseuri de echipamente electrice si
electronice (WEEE)

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/

recycling.




2. Configurarea monitoruluj

2. Configurarea monitorului

2.1 Instalare

El Continutul pachetului

%I%art

PHILIPS

DVI (optional)

VGA (optional)

E Instalarea suportului bazei

1.

Asezati monitorul cu fata in jos pe o
suprafatd moale si netedd, avand grijd sa nu
zgariati sau deteriorati ecranul.

Tineti suportul bazei monitorului cu ambele
madini si introduceti ferm suportul bazei n
santul special.

1) Atasati cu grija baza de coloana bazei
gn)
pana cand sistemul de prindere prinde
baza.

(2) Strangeti cu mana surubul din partea
inferioara a bazei si fixati bine baza de
coloana.




2. Configurarea monitoruluj

El Conectarea la computer

PHILIPS

£ @

=i

[1]
— @
0:

@ Intrare alimentare ca.
© Intrare VGA
© Intrare DVI-D (disponibild pentru anumite

modele)

O rort Kensington antifurt

Conectarea la PC

1.

Conectati ferm cablul de alimentare in
spatele monitorului.

Opriti computerul si deconectati cablul de
alimentare al acestuia.

Conectati cablul de semnal al monitorului
la conectorul video din partea posterioard
a computerului.

Conectati cablurile de alimentare ale
computerului si monitorului la o prizd din
apropiere.

Porniti computerul si monitorul. Dacd este
afisatd o imagine pe monitor, instalarea este
finalizata.

2.2 Manevrarea monitorului

El Descrierea produsului vazut din fata

190E3L:
/9\
@/v /A /4 /0K [0)
I I [\ | |
(7] (6] (3] (2] (1]
190E3L (pentru modelul 1A):
A
/v /A o ] /0K [0}
I I [\ | |
(7] (6] (4 J 3 (2] (1]
Pentru a porni si a opri
I
o O alimentarea monitorului.
© /0K |Pentru accesarea meniului OSD.
Revenirea la nivelul OSD
o < anterior.
o E |[Modificati formatul de afisare.
O-  |Reglati nivelul de luminozitate.
© | A V¥ |Pentru reglarea meniului OSD.
® Pentru a modifica sursa
0 semnalului de intrare.
O |Modificati formatul de afisare.
Smartlmage Lite. Puteti alege
®@ @ |dintre sase moduri: Standard,
Internet si Game (Jocuri).




2. Configurarea monitoruluj
B Descrierea afigirii pe ecran (OSD)

Ce inseamnd OSD (afisarea pe ecran)?

Toate monitoarele LCD Philips dispun de
caracteristica OSD (afisare pe ecran). Acest
lucru permite utilizatorului final sd selecteze

| - o . Main menu
functiile monitorului direct de pe ecran, prin
intermediul unei ferestre de instructiuni. Mai
jos este prezentatd o interfatd OSD, usor de — oput
utilizat:
190E3L: — Picture
— Color
— Language
— OSD Settings
FERRERINID 100
1 |

Setup

Instructiuni fundamentale si simple referitoare
la tastele de control

Tn meniul OSD de mai sus puteti apisa

pe butoanele Y A de pe rama frontald a
monitorului pentru a misca cursorul si puteti
apasa pe butonul OK pentru a confirma selectia
sau modificarea.

Meniul OSD

Mai jos, este prezentatd imaginea integrald
a structurii afisarii pe ecran. Puteti consulta
ulterior aceastd imagine, in cazul n care veti
dori sd navigati intre diferitele ajustdri.

Sub menu

L

VGA

DVI (available for selected model)

Picture Format
Brightness
Contrast

SmartContrast

Color Temperature
sRGB

User Define

Wide Screen, 4:3
0~100

0~100

On, Off

6500K, 9300K

Red: 0~100
Green: 0~100

Blue: 0~100

English . Espafiol, Francais, Deutsch, Italiano,

Portugués, Pycckuit, AL, Tiirkge

Horizontal
Vertical

Transparency

OSD Time Out

Auto
Power LED
H. Position
V. Position
Phase
Clock

Resolution Notification

Reset

Information

0~100
0~100
Off,1,2,3,4

5s, 10s, 20s, 30s, 60s

0,1,2,3,4
0~100
0~100
0~100
0~100
On, Off
Yes, No



2. Configurarea monitoruluj

E Notificarea privind rezolutia 2.3 Desfacerea suportului de la baza
Acest monitor este conceput pentru si a bazei

performante optime la rezolutia sa nativa, 1440

x 900 la 60 Hz. Dacd monitorul este pornit El Demontarea suportului de la baza

si este setat la o alta rezolutie, pe ecran se Tnainte de a incepe dezasamblarea bazei
afiseaza o alertd: Utilizati rezolutia 1440 x 900 monitorului, urmati instructiunile de mai jos

la 60 Hz pentru rezultate optime. pentru a evita deteriorarea monitorului sau
Afisarea alertei privind rezolutia nativd poate fi vitimarea corporalé.

dezactivati din Setup (Configurare) in meniul 1. Asezati monitorul cu fata in jos pe o

OSD (afisare pe ecran). suprafatd moale, avand grijd sa nu zgariati si

sa nu deteriorati ecranul.
a Functie fizica

Inclinare

2. Desfaceti suportul bazei din coloana bazei
astfel:

(1) Desurubati cu mana surubul aflat in
partea inferioard a bazei.

(2) Miscati usorin sus si n jos pentru a
decupla sistemul de blocare al bazei si
desprindeti baza din coloana bazei.




2. Configurarea monitorului

Bl Demontarea bazei

1. Puteti utiliza o surubelnitd cu cap pe care
sa o introduceti prin cele doua orificii ale
balamalei si folosi ca pe o parghie pentru a
scoate capacul balamalei.

2. Scoateti cele 4 suruburi si apoi desprindeti
baza de monitor.




3. Informatii despre produs

3. Informatii despre produs

3.1 Smartimage Lite

El Ce este?

Smartlmage Lite ofera presetdri care optimizeazd
afisajul pentru diferite tipuri de continut, regland
dinamic luminozitatea, contrastul, culoarea si
claritatea in timp real. Indiferent daca lucrati

cu aplicatii de text, de afisare de imagini sau
urmariti un videoclip, Philips Smartlmage Lite va
asigurd o performanta grozava si optimizatd a
monitorului.

E1 De ce am nevoie de acesta?

Dacad va doriti un monitor care vd asigura afisarea
optimizata a tuturor tipurilor de continut,
software-ul Smartimage Lite vd regleazd in mod
dinamic si in timp real luminozitatea, contrastul,
culorile si claritatea pentru a véd imbunatati
experienta vizuald cu acest monitor:

E Cum functioneaza?

Smartlmage Lite este o tehnologie exclusiva,

de ultimd generatie, de la Philips care analizeaza
continutul afisat pe ecranul dvs. Bazat pe

un scenariu pe care 1l selectati chiar dvs,,
Smartimage Lite imbundtateste In mod dinamic
contrastul, saturatia culorilor si claritatea
imaginilor, astfel incat calitatea continutului afisat
sd fie Imbundtatitd — toate acestea in timp real si
prin apdsarea unui singur buton.

Bl Cum se activeaza Smartlmage Lite?

1. Apdsati iy pentru a lansa afisarea pe ecran
a Smartlmage;

2. Tineti apasat pe & pentru a comuta intre
Standard, Internet si Game (Jocuri).

3. Afisarea pe ecran a Smartimage Lite va
rdmane pe ecran timp de 5 secunde sau
puteti apasa pe ,,OK” pentru a confirma.

4. Atunci cand Smartlmage Lite este activat,
schema sRGB este dezactivatd automat.
Pentru a utiliza sSRGB, trebuie sd dezactivati
Smartimage Lite cu butonul B de pe rama
frontald a monitorului.

Tn afari de utilizarea tastei B pentru a defila

n jos, puteti apdsa si pe butoanele w A pentru
selectare si pe ,,OK" pentru a confirma selectia
si a inchide afisarea pe ecran a Smartlmage.

Puteti alege dintre sase moduri: Standard,

Internet, Game (Jocuri).

@ SmartImage '™

Standard

Internet

«  Standard: Imbunititeste calitatea textului
si reduce luminozitatea pentru a creste
lizibilitatea si a reduce stresul asupra ochilor.
Acest mod imbunatateste semnificativ
lizibilitatea si productivitatea atunci cand
lucrati cu foi de calcul, fisiere PDF, articole
scanate sau alte aplicatii generale de birou.

* Internet: Acest profil combind saturatia de
culoare, contrastul dinamic si Tmbunatatirea
claritatii pentru a afisa fotografii si alte
imagini cu o claritate extraordinard si in
culori vii — toate fara artefacte si culori
sterse.

*  Game (Jocuri): Activand circuitul overdrive
pentru cel mai bun timp de rdspuns,
reducand marginile n zigzag pentru
obiectele cu miscare rapidd pe ecran,
imbunatatind raportul de contrast pentru
scenele luminoase si intunecoase, acest
profil asigurd cea mai bund experientd de
joc pentru Tmpatimitii de jocuri.




3. Informatii despre produs

3.2 SmartContrast

El Ce este?

Tehnologie unica ce analizeaza dinamic
continutul afisat si optimizeazd automat
raportul de contrast al monitorului LCD
pentru claritate vizuala maxima si experientd
vizuald Tncantatoare, crescand retroiluminarea
pentru imagini mai clare, mai contrastante si
mai luminoase sau reducand retroiluminarea
pentru afisarea clard a imaginilor pe fundaluri
ntunecate.

1 De ce am nevoie de acesta!

Doriti cea mai buna claritate vizuala si confort
de vizualizare pentru fiecare tip de continut.
SmartContrast controleaza dinamic contrastul

si regleaza retroiluminarea pentru ca imaginile
jocurilor si cele video sa fie clare, contrastante

si luminoase sau afiseaza test clar, lizibil pentru
munca de birou. Prin reducerea consumului
electric al monitorului, puteti reduce costurile cu
energia si prelungi durata de viatd a monitorului.

E Cum functioneaza?

Atunci cind activati SmartContrast, acesta va
analiza in timp real continutul afisat pentru a
ajusta culorile si pentru a controla intensitatea
iluminarii de fundal. Aceasta functie va
fmbunatati in mod dinamic contrastul pentru o
experientd de divertisment grozavd atunci cand
vizionati videoclipuri sau va jucati.

3.3 Philips SmartControl Lite

Noul software SmartControl Lite de la Philips va
permite sa controlati monitorul prin intermediul
unei interfete grafice afisate pe ecran si usor de
utilizat. Regldrile complicate fac parte din trecut
deoarece acest software usor de utilizat vd ajutd
sa reglati fin rezolutia, s calibrati culorile, sd
reglati frecventa/faza, sa reglati punctul de alb
RGB etc.

Echipata cu cea mai recentd tehnologie care
constd fntr-un algoritm central pentru procesare
si raspuns rapide, aceasta pictograma animata
atrdgdtoare bazata pe un software compatibil cu
Windows este gata sd va intensifice experienta
cu monitoarele Philips!

10

El Instalare

Urmati instructiunile si terminati instalarea.
Puteti lansa software-ul dupa finalizarea
instaldrii.

Daca doriti sd lansati mai tarziu, puteti sa
faceti clic pe comanda rapidd de pe desktop
sau de pe bara de instrumente.

PHILIPS e g e piczrre

Monitor driver and software installation

Prima lansare - Wizard (Expert)

Tn momentul primei instaliri a SmartControl

Lite, Tnainte de lansare se va deschide in

mod automat Wizard (Expert).

Expertul va va ghida pas cu pas pe parcursul

reglarii performantei monitorului dvs.

Puteti merge la meniul Plug-in pentru a

lansa expertul mai tarziu.

Puteti regla mai multe optiuni fard expertul

din panoul Standard.
L 1

SmartControl Lite PHILIPS

Wizard

=

Adhst

£ d
L4

‘ \n iﬂ“



3. Informatii despre produs
E incepeti cu panoul Standard:

Meniul Adjust (Reglare):

*  Meniul Adjust (Reglare) va permite sa reglati
setdrile pentru Brightness (Luminozitate),
Contrast, Focus (Focalizare), Position
(Pozitie) si Resolution (Rezolutie).

*  Puteti urma instructiunile si efectua reglarea.

*  Cancel (Anulati) mesajele pentru utilizator
daca doriti sd anulati instalarea.

[ f—— Tz |

SmartControl Lite PHILIPS

= =
= B |
Options. “ ———— e —
=)
[T %)
SmartControl Lite PHILIPS
Contrast
‘ . =
5 2
oy - 4 . .
Options. “ ———— e —
=)

"

| (3] smarcanses tan

SmartControl Lite

ssad

b
Forinem

+ s

z
3
g

£

g

1x]
PHILIPS

}

SmartControl Lite

geaR

in s e

in
i

T |
PHILIPS

|

SmartControl Lite

i e

=

T |

PHILIPS




3. Informatii despre produs

Meniul Color (Culori):

*  Meniul Color (Culori) vd permite sa reglati
setdrile pentru RGB, Black Level (Nivel de
negru), White Point (Punct de alb), Color
Calibration (Calibrare culori) si Smartlmage
Lite (consultati sectiunea Smartimage Lite).

»  Puteti urma instructiunile si efectua reglarea.

*  Consultati tabelul de mai jos pentru
elementul din submeniu pe baza introducerii
dvs.

*  Exemplu pentru Color Calibration (calibrare
culoare)

T ey

25

SmartControl 1t PHILIPS

Black Level

2 #ﬁl

i
i

&
=
> &
=
&

i
L]

o

1.5}
PHILIPS |

-l = o & |

Coepin

Smrtirage

12

1] S Lae iz

SmartControl 1* PHILIPS

Calibration

Pestected by 5. Patest e 6,080,830

gada

1., Show Me"” (Arata-mi) porneste tutorialul
de calibrare a culorii.

2. Start - porneste secventa de calibrare a
culorii in 6 pasi.

e

Quick View (Vizualizare rapidd) incarca
imaginile Tnainte/dupd.

4. Pentru a reveni la fila initiala Color (Culori),
faceti clic pe butonul Cancel (Revocare).

5. Enable color calibration (Activare calibrare
culori) - este activata in mod implicit. Daca
este debifatd, aceastd optiune nu permite
calibrarea culorilor, estompeaza butoanele
de lansare si de vizualizare rapida.

6. Trebuie sa aveti informatii brevetate in
ecranul de calibrare.

Ecran de calibrare a primei culori:

* Butonul Previous (Anteriorul) este
dezactivat pand la al doilea ecran de culoare.

*  Butonul Next (Urmatorul) trece la
urmadtoarea tinta (6 tinte).



3. Informatii despre produs

»  Butonul Final merge la fila File > Presets
(Fisier > Presetari).

»  Butonul Cancel (Revocare) Inchide interfata
cu utilizatorul si revine la pagina de plug-in.

Smartlmage Lite
Permite utilizatorului sa schimbe setarea pentru

Atunci cand este setatd optiunea
Entertainment (Divertisment), SmartContrast si

SmartResponse sunt activate.

g [ —— 7%

SmartControl Lite PHILIPS
Senart Image
\g L3
= =
. .
i .
Qjﬂ
® - =
= ° &

Options > Preferences (Optiuni > Preferinte)
- va fi activd doar cand selectati Preferences
(Preferinte) din meniul vertical Options
(Optiuni). Pe un afisaj neacceptat compatibil
DDC/CI, sunt disponibile doar filele Help
(Ajutor) si Options (Optiuni).

| 13] smarsamtrei .20 T
[
SmartControl ¢ PHILIPS

Prefesences

) “E ""
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* Afiseaza setdrile preferate curente.

* O bifa activeaza functia. Caseta de selectare
este un comutator.

* Caseta Enable Context Menu (Activare
meniu contextual) de pe desktop este
setatd la (On) (Activat) in mod implicit.
Enable Context menu (Activare meniu
contextual) afiseaza selectiile SmartControl
Lite pentru Select Preset (Selectare
informatii prestabilite) si Tune Display
(Reglare afisaj) in meniul contextual de pe
desktop deschis prin clic dreapta. Disabled
(Dezactivarea) elimind SmartControl Lite
din meniul contextual deschis prin clic
dreapta.

* Pictograma Enable Task Tray (Activare bard
de sarcini) este setata la (On) (Activat)

n mod implicit. Enable context menu
(Activare meniu contextual) afiseaza bara
de instrumente pentru SmartControl Lite.
Un clic dreapta pe pictograma barei de
sarcini afiseaza optiunile de meniu pentru
Help (Ajutor), Technical Support (Asistentd
tehnicd), Check for Update (Verificare
actualizari), About (Despre) si Exit (lesire).
Atunci cand meniul Enable task tray
(Activare bard de sarcini) este dezactivat,
pictograma barei de sarcini va afisa doar
EXIT (IESIRE).

Optiunea Run at Startup (Executare la
lansare) este setatd la (Activat) in mod
implicit. Atunci cand aceastd optiune este
dezactivatd, SmartControl Lite nu se va
lansa la pornire si nu va fi in bara de sarcini.
Singurul mod de a lansa SmartControl
Lite este fie de la comanda rapidd de pe
desktop, fie din fisierele program. Orice
presetare setatd sd se execute la lansare
nu se va incdrca cand aceasta casetd este
debifatd (Dezactivat).

* Enable transparency mode (Activare
mod transparent) (Windows 7,Vista,
XP).Valoarea implicitd este 0% Opaque
(Opacitate 0%).

Options >Input (Optiuni > Intrare) - va
fi activd doar cand selectati Input (Intrare)
din meniul vertical Options (Optiuni). Pe un
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afisaj neacceptat compatibil DDC/CI, sunt
disponibile doar filele Help (Ajutor) si Options
(Optiuni). Celelalte file SmartControl Lite sunt
indisponibile.
T i e ix
SmartControl Lite PHILIPS

Input

Ansiog in Dgtal

« Afisati panoul de instructiuni Source (Sursa)
si setarea sursei de intrare curente.

* La afisajele cu o singurd intrare, acest panou
nu va fi vizibil.

Options (Optiuni)>Audio - va fi activa doar

cand selectati Audio din meniul vertical Options

(Optiuni).

Pe un afisaj neacceptat compatibil DDC/CI, sunt

disponibile doar filele Help (Ajutor) si Options

(Optiuni).
T 1x

SmartControl Lite PHILIPS

Auvdio

4
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Help>User Manual (Ajutor>Manual de
utilizare) - va fi activa doar cand selectati User
Manual (Manual de utilizare) din meniul vertical
Help (Ajutor). Pe un afisaj neacceptat compatibil
DDC/CI, sunt disponibile doar filele Help
(Ajutor) si Options (Optiuni).

e 1x

PHILIPS

SmartControl Lite

User Manual

3@ §ﬁ %i ii

var Warsaal Tack. Gupport

Help >Version (Ajutor > Versiune) - va fi
activd doar cand selectati Version (Versiune)

din meniul vertical Help (Ajutor). Pe un afisaj
neacceptat compatibil DDC/CI, sunt disponibile
doar filele Help (Ajutor) si Options (Optiuni).

f[P—— T
SmartControl Lite PHILIPS

Version

.
— »
@

Meniul Contextual

Context Sensitive menu (Meniul Contextual)
este setat la Activat Tn mod implicit. Dacd ati

bifat Enable Context Menu (Activare meniu



3. Informatii despre produs

contextual) in fila Options > Preferences
(Optiuni > Preferinte), atunci meniul va fi vizibil.

@ SmartControl
Belect Presst L4
Tune Dizplagr

in Meniu contextual existi patru optiuni:

»  SmartControl Lite - cand este selectat, se
afiseaza About (Despre) ecran.

*  Select Preset (Selectare informatii
prestabilite) - oferd un meniu ierarhic al

presetdrilor salvate pentru utilizare imediata.

O bifd afiseazd presetarea selectatd in
mod curent. Factory Preset (Presetare din
fabrica) poate fi apelata din meniul vertical.
* Tune Display (Reglare afisaj) — deschide
panoul de control SmartControl Lite.
*  Smartlmage Lite - verifica setdrile curente,
Standard, Internet, Game (Jocuri).

Meniul Bara de sarcini activat

Meniul barei de sarcini poate fi afisat facand clic
dreapta pe pictograma SmartControl Lite din
bara de sarcini. Un clic pe butonul din stanga al
mouse-ului va lansa aplicatia.

Help

Technical Support
Check for Update
About

Exik

Bara de sarcini are cinci optiuni:

* Help (Ajutor) - acces la fisierul User Manual
(Manual de utilizare): Deschide fisierul
User Manual (Manual de utilizare) utilizand
fereastra browserului implicit.

+ Technical Support (Asistentd tehnicd) -
afiseaza pagina de asistentd tehnica.

*  Check for Update (Verificare actualizari)
- conduce utilizatorul la PDI Landing si

15

verificd dacd versiunea utilizatorului este cea
mai recentd versiune disponibila.

* About (Despre) - afiseaza informatii de
referintd detaliate: versiunea produsului,
informatii referitoare la distributie si numele
produsului.

*  Exit (lesire) - inchide SmartControl Lite

Pentru a executa SmartControl Lite din nou,
selectati SmartControl Lite din meniul Program,
faceti dublu clic pe pictograma de pe desktopul

sistemului PC sau reporniti sistemul.

PHILIPS

SmartControl

2010 MWD
Powered by Display Tune(R)

All Rights Reserved

Copyright of Suppliers Acknowledged

Meniul Bara de activitati dezactivat

Cand bara de sarcini este dezactivata in folderul
de preferinte, este disponibild doar optiunea
EXIT (IESIRE). Pentru a elimina complet
SmartControl Lite din bara de activitati,
dezactivati Run at Startup (Executare la
lansare) din Options >Preferences (Optiuni >
Preferinte).
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4. Specificatii tehnice

Tip ecran LCD

TFT-LCD

[luminare fundal

LED

Dimensiune panou

19" L (48.26cm)

Raport aspect

1610

Distanta dintre pixeli

0,2835 x 0,2835 mm

Luminozitate 250 cd/m?
SmartContrast 20.000.000:1
Raport contrast (tipic) 1000:1
Timp de raspuns (tipic) 5 ms

Rezolutie optima

1440 x 900 la 60 Hz

Unghi de vizualizare

170° (O) / 160° (V) @ C/R>10

Imbunatatire imagine

Smartlmage Lite

Culori ecran

16,7 M

Ratd de improspdtare pe verticald

56 Hz — 76 Hz

Frecventa orizontala

30 kHz — 83 kHz

sRGB

DA

Semnal intrare DVI (digital), VGA (analogic)

Intrare semnal

Comoditate pentru utilizator

Sincronizare separatd, Sincronizare la verde

190E3L: ED/Vv ©/A /4 /0K 0}
190E3L(1A): B/ TN 0/ 4 /0K 0)

Limbi OSD

Englezd, franceza, germang, italiand, rusd, spaniold, chineza
simplificatd, portughezd, turca

Alte avantaje

Dispozitiv de blocare Kensington

Compatibilitate Plug & Play

Inclinare

DDC/CI, sRGB, Windows 7, Mac OSX, Linux

-5/4+20

Mod pomit

17.77W (tipic), 18.98W (max.)

Consum energie (Metodd de
testare EnergyStar 5.0)

Tensiune de intrare
ac la100V ac
+/-5V a.c, 50 Hz
+/-3Hz

Tensiune de intrare
ac la115Vac
+/-5V a.c, 60 Hz
+/-3Hz

Tensiune de intrare
ac la230Vac
+/-5V a.c, 50 Hz
+/-3Hz

Disipare cdldura®

+/-5V ac, 50 Hz
+/-3Hz

+/-5V ac, 60 Hz
+/-3Hz

Functionare normala (tipic) 14,5W 144W 14,37W

Inactiv 0,5wW 0,5W 0,5W

Oprit 0,5W 0,5W 0,5W
Tensiune de intrare | Tensiune de intrare | Tensiune de intrare
ac la100V ac ac. la115Vac ac la230Vac

+/-5V ac, 50 Hz
+/-3Hz
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Functionare normala 49,49 BTU/hr 49,15 BTU/hr 49,04 BTU/hr
Inactiv 1,71 BTU/hr 1,71 BTU/hr 1,71 BTU/hr
Oprit 1,71 BTU/hr 1,71 BTU/hr 1,71 BTU/hr
Indicator de alimentare Mod pomit: Alb, Stare de veghe/de repaus: Alb (intermitent)
Alimentare Incorporats, 100-240VAC, 50-60Hz

Produs cu suport (LxixA) 463,59 x 390,93 x 199,8 mm

Produs fird suport (LxixA) 463,59 x 320,46 x 41,1 mm

Produs cu suport 3,1%kg

Produs fard suport 2,8kg

Produs cu ambalaj 4,45kg

Interval de temperatura Intre 0°C si 40°C

(functionare)

Interval de temperatura Tntre -20°C si 60°C

(nefunctionare)

Umiditate relativa Intre 20% si 80%

Mod de operare: + 3.658 m (12.000 ft)

AIETRIIS Nefunctionare: + 12192 m (40.000 ft)
MTBF 30.000 h

ROHS DA

EPEAT Silver (www.epeat.net)

Ambalare 100% reciclabil

Norme de reslementar Marca CE, FCC Clasa B, GOST, SEMKO, Certificat TCO, UL/

orme de regiementare cUL, BSMI, 1509241-307
Culoare Negru (in spate), albastru (in fatd)
Emailat Strélucitor

6 Noti

1. EPEAT Gold sau Silver este valid doar daca Philips a Tnregistrat produsul.Vizitati site-ul www.epeat.
net pentru a verifica starea Inregistrarii in tara dvs.

2. Aceste date pot suferi modificari fara notificare. Accesati www.philips.com/support pentru a
descarca ultima versiune a instructiunilor.
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4.1 Rezolutie si moduri de presetare

E Rezolutie maxima
1440 x 900 la 60 Hz (intrare analogica)
1440 x 900 la 60 Hz (intrare digitald)

E1 Rezolutie recomandata
1440 x 900 la 60 Hz (intrare digitala)

480i 720 x 480 SD |60

480p 720 x 480 SD (60

576i 720 x 576 SD |50

576p 720 x 576 SD (50

720p 1280 x 720 HD |50, 60

1080i 1920x1080 | HD (50, 60

1080p | 19201080 | HD (50, 60

& Not

Retineti cd afisajul dvs. functioneazd cel mai
bine la o rezolutie nativa de 1440 x 900 la 60
Hz. Pentru calitate optima a afisajului, respectati
rezolutia recomandata.
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5. Gestionarea consumului
de energie

Daca aveti placa video sau program software
conforme cuVESA DPM instalate pe PC,
monitorul poate reduce automat consumul
de energie atunci cand nu este utilizat. Daca
este detectatd o introducere de la tastaturd,
mouse sau alt dispozitiv de intrare, monitorul
se va ,trezi” automat. Urmatorul tabel indica
consumul de energie si semnalizarea acestei
functii de economisire automatd a energiei:

Mod VESA | Video |Sinc O | Sinc V |Energie consumata Ctlagre
Aciv  [PORNIT| Da | Da | S1777W Alb
(normal)
" Alb
Inactiv OPRIT | Nu Nu |<05 W (normal) (clipitor)
Oprire [ OPRIT - - <05 W (normal) | OPRIT

Configurarea urmatoare este utilizata pentru a
masura consumul de energie al acestui monitor.

e Rezolutie nativa:1440 x 900
»  Contrast: 50%
e Luminozitate: 250 niti

*  Temperaturd de culoare: 6500 k la alb rece
complet

& Not

Aceste date pot suferi modificdri fara notificare.
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6. Informatii despre
reglementari

Lead-free Product

Lead free display promotes
environmentally sound recovery

@ and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
J.E_E carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact on
the climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

» Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development

in co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document, Ver. 2.1

I[u Technology for you and the planet
CERTIFIED
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EPEAT
(www.epeat.net)
™  The EPEAT (Electronic
Qp Product Environmental
)

Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on

51 environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR'’s energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

» EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

«  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

»  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

+ EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

*  2006/95/EC (Low Voltage Directive).

»  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2009 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

¢ MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.
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Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

(rarf

ENERGY STAR

i

6 Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

© This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.

22

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.
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Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices as described in EN 55022, unless it is spacii-
cally stated that it ia a Class A devics on the specilication labal. The following apglies to
devices in Class A of EN 55022 (radius of protection up 1o 30 meters). The user of the
davics is obliged to take all staps necessary to remove sources of interfarence 1o tals-
communication or othar devicas.

Pokud nani na typovém &thu potstaie uvedena, #. spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tidy A (chranné
pésma 30m) podle EN 55022 platl nésledujicl. Dojde-li k rullan! telskomunikataich nebo
finjich zafizeni e iivatal povinnen provést takové opatfgni, sty ruen odstranil

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badarn | Certyfikacji

Uraspdectie powiana byt rasilane # gaiasds # przybaczonym obwodem ocheomnyo (gniszda ¢
Katkiens} Wapi\'admgact ‘i 5o rzadsenia (komputer, monitor, drukarka) powinty byt zsilane
2 1eg0 samego b
Instalaja elekarycama pomiesacsents powiana sawieral w praewadse fazoym ez ke
proed swazciami, w postaci berpseconika o wartobel mamionawe] nie wickszej niz 16A (amperiw).
W el calkewitege wylpeeenis urqdzenia 2 sieer zasilanta, naledy wyjad wiyceke kabla
easilaigeepo 2 priaedka, kidre powinno snjdowad sig w pobliz udemna 1 b Barwo dostepne.
Tnak bespiecaefarw "B” patwiendes 2podaosé uresdienia  wynaganiami hespiecaetstwa
wkytkowania cowanyini w PN-SETAZI07 § PR-E 6251

Pozostale instrukeje bezpieczensiwa

*  Nie malezy usywad wiyezek daptercwych Tub usuwaé kolka abwodu ochrarnega 2 wiyeeki.

Jepeli konsecane jest ey eie |l).\.'d|unal:ﬂa o malezy wiyé preediuzace 3-pylowego &

Systems ¥ mleiy ¢ praed magkymi, ymi werostami lub spad-
kami mapsgeia, wiywajac eliminatora proepié, uresdrenia dopasowijycege lub

bezzaklicenivwegn srodis rasilania.

* Naley upewni sie. shy nic nic lealo na kablach systenu kompuieroweo, araz aby kalbde nic
by urni W thlegscu, pdzse modna byboby na nie nadeptywad lub pocyksd sig o e,

* Niemaledy rosewad napab i nayel plyab s systens koeputesony.

Nie naleiy wpychat sadnych p dvw systemm , iy moie

1o spowndmwag poiar |uhpmmmpqdm poprzez mwarcie elemenidm wewmgtrenych

* System komputerowy powitsien znajdowad sig 2 dala od grzejaikiw ¢ idel elepla. Porsdro,
i ey blakawad atwordw wenylacynych. Nalezy unikac kludzensa luinyeh papierdw pod

karmputera w i cyrhalacii powi-
etz wokil niego.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RHAZHERERZIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



6. Informatii despre reglementari
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Centre de asistenta
pentru clienti si garantie

7.1 Politica Philips privind defectele
de afisare a pixelilor pentru

monitoarele plate
Philips depune eforturi deosebite pentru a livra
produse de cea mai buna calitate. Utilizdm
unele dintre cele mai avansate procese de
fabricatie din aceastd industrie si practicam un
control al calitatii foarte strict. Cu toate acestea,
defectele de afisare a pixelilor si a subpixelilor
pe ecranele LCD TFT utilizate la monitoarele
plate sunt uneori inevitabile. Niciun producdtor
nu poate garanta cd toate ecranele vor
functiona fara defecte de afisare a pixelilor, dar
Philips garanteazd cd toate monitoarele cu un
numar de defecte inacceptabil vor fi reparate
sau Tnlocuite conform conditiilor de garantie.
Acest aviz explicd diferitele tipuri de defecte
de afisare a pixelilor si defineste nivelurile
acceptabile pentru fiecare tip de defect. Pentru
a intra sub incidenta conditiilor prevdzute de
garantie pentru reparare sau fnlocuire, numarul
de defecte de afisare a pixelilor pe un ecran
LCD TFT trebuie sd depdseasca aceste niveluri
acceptabile. De exemplu, un monitor nu trebuie
sa aiba defecti mai mult de 0,0004% dintre
subpixeli. Philips fixeaza standarde de calitate si
mai ridicate pentru anumite tipuri sau combinatii
de defecte de afisare a pixelilor, care sunt mai
usor de observat decat altele. Aceastd politica
este valabild in Tntreaga lume.

subpixeli subpixeli subpixeli
SUUPIAEI SUDPIAEI  SUDPIAEE

vy

H H
Pixeli si subpixeli
Un pixel sau un element de imagine este
compus din trei subpixeli in culorile primare
rosu, verde si albastru. Un numar mare de pixeli
formeaza impreund o imagine. La aprinderea
tuturor subpixelilor dintr-un pixel, cei trei

subpixeli colorati sunt perceputi ca un singur
pixel alb. Cand toti subpixelii sunt stinsi, cei trei

RGBES

pixeli
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subpixeli colorati sunt perceputi ca un singur
pixel negru. Diverse alte combinatii de subpixeli
aprinsi si stinsi sunt percepute ca pixeli singuri
de diverse culori.

Tipuri de defecte de afisare a pixelilor
Defectele de afisare a pixelilor si subpixelilor
apar pe ecran in diferite moduri. Exista doud
categorii de defecte de afisare a pixelilor si mai
multe tipuri de defecte de afisare a subpixelilor
in cadrul fiecarei categorii.

Defectele de tip punct luminos

Aceste defecte apar ca pixeli sau subpixeli ce
sunt permanent aprinsi sau ,,in functiune”. Cu
alte cuvinte, un punct luminos este un subpixel
ce iese Tn evidentd pe ecran, atunci cand este
afisatd o imagine de culoare inchisd. Defectele
de tip punct luminos sunt de urmatoarele tipuri:

(€

Un subpixel aprins, de culoare rosie, verde sau
albastra.

I C

Doi subpixeli adiacenti aprinsi:

- Rosu + Albastru = Violet

- Rosu + Verde = Galben

- Verde + Albastru = Cian (Albastru deschis)

Trei subpixeli adiacenti aprinsi (un pixel alb).
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e Noti Gradul de asemanare a defectelor de afisare a
pixelilor

Deoarece defectele de acelasi tip ale pixelilor
si subpixelilor aldturati sunt mai usor de sesizat,
Philips precizeazd si limite de toleranta pentru
proximitatea defectelor de afisare a pixelilor:

Punctele luminoase rosii sau albastre sunt

cu peste 50% mai strdlucitoare decat cele
nvecinate, in timp ce punctele verzi sunt cu 30%
mai stralucitoare.

Defectele de tip punct negru

Aceste defecte apar ca pixeli sau subpixeli ce
sunt permanent intunecati sau ,stinsi”’. Cu alte
cuvinte, un punct intunecat este un subpixel

ce iese In evidenta pe ecran, atunci cand este

afisatd o imagine de culoare deschisa. Defectele .
de tip punct negru sunt de urmdtoarele tipuri:

pixelilor

Pentru ca produsul sd intre sub incidenta
conditiilor pentru reparare sau Tnlocuire

din cauza defectelor de afisare a pixelilor in
perioada de garantie, ecranul LCD TFT al unui
monitor plat Philips trebuie sa aibd defecte

de afisare a pixelilor sau subpixelilor care

sa depdseascd limitele de tolerantd listate in
urmdtoarele tabele.

I Tolerante pentru defectele de afisare a

DEFECTE DE AFISARE DE TIP PUNCT LUMINOS NIVEL ACCEPTABIL
1 subpixel aprins 3

2 subpixeli adiacenti aprinsi 1

3 subpixeli adiacenti aprinsi (un pixel alb) 0
Distanta dintre doud defecte de afisare de tip ,,punct luminos’* >15 mm
Numdrul total de defecte de afisare de tip , punct luminos” 3

1 subpixel stins 5 sau mai putini
2 subpixeli adiacenti stinsi 2 sau mai putini
3 subpixeli adiacenti stinsi 0
Distanta dintre doud defecte de afisare de tip , punct intunecat’* >15 mm
Numarul total de defecte de afisare de tip , punct intunecat” 5 sau mai putini
Numarul total de defecte de afisare (puncte luminoase si 5 sau mai putini
intunecate)

& Noti

1. 1 sau 2 subpixeli adiacenti defecti = 1 defect de afisare a punctelor
2. Acest monitor este conform ISO 9241-307. ( ISO 9241-307: Ergonomie, metode de incercdri de
analiza si conformitate pentru videoterminale electronice)
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7.2 Centre de asistenta pentru clienti si garantie

Pentru informatii referitoare la acoperirea garantiei si la asistantd suplimentard pentru validarea in
regiunea dvs, vizitati site-ul Web www.philips.com/support pentru detalii. De asemenea, puteti contacta

Centrul local Philips pentru asistentd clienti la numerele de mai jos.

Informatii de contact pentru regiunea Europei de Vest:

A

Germany Siemens &S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff

28




. Centre de asistenta pentru clienti si garantie

Informatii de contact pentru regiunea Europei Centrale si de Est:

e A

Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
;egt;'; f‘egm NA Kim Tec d.oo. +381 11 20 70 684
Slovenia NA PC Hand +386 1 530 08 24
e NA Comel +380 562320045
NA Topaz-Service Company | +38 044 245 73 31
S NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 1 2426331
NA Profi Service +36 1 814 8080

Informatii de contact pentru regiunea Americii Latine:

Tara

Brazil

Centru asistenta telefonica

Argentina

Vermont

Telefon asistenta clienti
0800-7254101

0800 3330 856

Informatii de contact pentru China:

China

Telefon asistenta clienti: 4008 800 008

Informatii de contact pentru America de Nord:

USA.

TOS

A

Teleplan

(877) 835-1838

Canada

Supercom

Supercom

(800) 479-6696
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Informatii de contact pentru regiunea Asiei Pacifice, Orientului Mijlociu si Africii:

buy-out)

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 10 56677
Indonesia NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
' Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA ft’é's Computer System Co. | 4051 934.5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
Unllted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
. . +84 8 38248007 Ho Chi Minh City
Vietham NA EPT Se“’"‘it'd”fo”“at'c +84 5113562666 Danang City
ST +84 5113.562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no dfstrlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
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8. Depanare si intrebari
frecvente

8.1 Depanare

Aceastd pagina trateaza probleme care pot
fi corectate de un utilizator. Daca problema
persista dupd ce ati incercat aceste solutii,
contactati reprezentantul de service pentru
clienti Philips.

El Probleme obisnuite

Fara imagine (LED-ul de alimentare este stins)

e Verificati daca ati conectat cablul de
alimentare la priza electricd si in spatele
monitorului.

*  Maiintdi, verificati dacd butonul de pornire
din fata monitorului este in pozitia oprit
(OFF), apoi apdsati-l in pozitia pornit (ON).

Fara imagine (LED de alimentare alb)

» Verificati dacd ati pornit computerul.

e Verificati daca ati conectat corect cablul de
semnal la computerul dvs.

*  Asigurati-va cd nu sunt pini indoiti n
conectorul cablului monitorului. Dacd da,
reparati sau inlocuiti cablul.

» Functia Energy Saving (economisire energie)
poate fi activatd

Pe ecran se afiseaza

Attention

Check cable connection

* Verificati daca ati conectat corect cablul
monitorului la computer. (Consultati si
Ghidul de pomnire rapidd).

»  Verificati dacd pinii cablului monitorului sunt
ndoiti.

» Verificati dacd ati pornit computerul.

Butonul AUTOMAT nu functioneaza
¢ Functia Auto este aplicabild doar in modul
VGA-Analogic. In cazul n care nu sunteti
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multumit de rezultate, puteti face ajustarile
manual din meniul OSD.

& Noti

Functia Auto nu se aplica Tn modul DVI-digital
deoarece nu este necesard.

Semne vizibile de fum sau scantei

*  Nu executati niciunul dintre pasii de
depanare

*  Deconectati imediat, pentru siguranta,
monitorul de la sursa principala de
alimentare

» Contactati imediat serviciul de relatii cu
clientii Philips.

Bl Probleme cu imaginea

Imaginea nu este centrata

»  Ajustati pozitia imaginii utilizand functia
,Auto” din comenzile principale OSD.

*  Reglati pozitia imaginii folosind Phase/Clock
(Fazd/Frecventd) din Setup (Configurare) in
Comenzi principale OSD. Aceastd optiune
este valida doar in modul VGA.

Imaginea vibreaza pe ecran
* Verificati daca ati fixat corect cablul de
semnal la placa graficd sau la PC.

Apare o palpaire pe verticala

*  Ajustati imaginea utilizand functia , Auto”
din comenzile principale OSD.

e Eliminati barele verticale utilizind Phase/
Clock (Faza/Frecventd) din Setup
(Configurare) in Comenzi principale OSD.
Aceasta optiune este validd doar in modul
VGA.

Apare o palpaire pe orizontala

* Ajustati imaginea utilizand functia ,,Auto”
din comenzile principale OSD.
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e Eliminati barele verticale utilizaind Phase/
Clock (Faza/Frecventd) din Setup
(Configurare) in Comenzi principale OSD.
Aceastd optiune este valida doar in modul
VGA.

Imaginea este neclara, vaga sau prea intunecata

*  Reglati contrastul si luminozitatea din afisajul
de pe ecran.

O ,,imagine persistenta”, o ,,imagine arsa” sau

o ,imagine fantoma” ramane dupa oprirea

alimentarii.

* Afisarea neintrerupta a imaginilor statice
pe o perioada extinsa de timp poate cauza
,,arderea”, cunoscuta si ca , persistenta
imaginii’’ sau crearea unei ,,imagini fantoma”,
pe ecranul dvs. ,Imaginea arsa”, ,imaginea
persistentd” sau ,imaginea fantoma”
reprezintd un fenomen binecunoscut in
tehnologia ecranelor LCD. In majoritatea
cazurilor, ,imaginea arsd” sau ,,persistenta
imaginii” sau ,imaginea fantoma” va disparea
treptat intr-o perioada de timp dupa ce
alimentarea este opritd.

* Activati Intotdeauna un economizor
ecran cu miscare cand lasati monitorul
nesupravegheat.

* Activati intotdeauna o aplicatie periodica
de Tmprospatare a ecranului atunci cand
monitorul LCD va afisa un continut static.

*  Simptomele grave de ,imagine arsd”,
,imagine persistentd” sau ,imagine fantomd’
nu vor disparea si nu pot fi reparate.
Deteriorarea mentionata mai sus nu este
acoperitd de garantie.

Imaginea este distorsionata. Textul este neclar

sau Incetosat.

e Setati rezolutia de afisare a PC-ului la acelasi
mod cu rezolutia nativda recomandata a
monitorului.

Pe ecran apar puncte verzi, rosii, albastre,

intunecate si albe

* Punctele remanente sunt o caracteristicd
normala a cristalelor lichide utilizate n
tehnologia actuald. Pentru mai multe detalii,
consultati politica referitoare la pixeli.

Indicatorul ,,alimentare pornita” este prea
puternic si deranjant
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»  Puteti regla indicatorul , .alimentare pornita”
utilizand meniul Setup (Configurare)
aferent LED-ului de alimentare in Comenzi
principale OSD.

Pentru asistenta suplimentard, consultati lista
cu Centrele de informare a consumatorilor

si contactati reprezentantul serviciului clienti
Philips.

8.2 Intrebiri frecvente SmartControl
Lite

1. Schimb monitorul de la un PC la altul
si SmartControl Lite devine inutilizabil.
Ce trebuie sa fac?

Rasp.: Reporniti PC-ul si verificati daca

SmartControl Lite functioneaza. Daca nu,

va trebui sa dezinstalati si sa reinstalati

SmartControl Lite pentru a vd asigura ca

este instalat driverul corect.

12. SmartControl Lite functiona bine
nainte, acum insa nu mai functioneaza
deloc. Ce trebuie sa fac?

Daca urmatoarele actiuni au fost
efectuate, s-ar putea sd fie necesard
reinstalarea driverului monitorului.

Ati schimbat adaptorul grafic video cu
altul

* Ati actualizat driverul video

Activitati in SO, precum service pack sau
fisier de corectie

Ati rulat Windows Update si ati
actualizat driverul pentru monitor si/sau
driverul video

* Windows a pornit cu monitorul oprit
sau deconectat.

Pentru a afla, faceti clic dreapta pe

My Computer (Computerul meu) si
faceti clic pe Properties (Proprietati)-
>Hardware-> Device Manager (Manager
dispozitive).

* Daca sub Monitor se afiseazd ,,Plug and
Play Monitor” (Monitor plug and play),
este necesard reinstalarea. Este necesar
doar sa dezinstalati SmartControl Lite si
sa 1l reinstalati.

Rasp.:
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i3.

Rasp.:

Rasp.:

Dupa instalarea SmartControl Lite,
atunci cand fac clic pe fila SmartControl
Lite, nu se afiseaza nimic nici dupa
citeva secunde sau se afigeaza un mesaj
de eroare. Ce s-a intdmplat?

Este posibil ca adaptorul grafic sa nu fie
compatibil cu SmartControl Lite. Daca
adaptorul grafic apartine unora dintre
marcile mentionate mai sus, incercati
sa descarcati cel mai recent driver al
adaptorului grafic de pe site-ul Web al
companiilor corespunzatoare.

Instalati driverul. Dezinstalati
SmartControl Lite si reinstalati-l.

Daca acesta inca nu functioneaza,
fnseamnd ca adaptorul grafic nu este
compatibil. Vizitati site-ul Web Philips si
verificati dacd este disponibil un driver
Lite.

Atunci cand fac clic pe Product
Information (Informatii produs), se
afiseaza doar informatii partiale. Ce s-a
intdmplat?

S-ar putea ca versiunea driverului
adaptorului placii dvs. grafice sd nu fie
cea mai recentd versiune care sa fie
complet compatibild cu interfata DDC/
Cl.incercati sa descircati cel mai actual
driver de adaptor grafic de pe site-ul
Web al companiilor corespunzatoare.
Instalati driverul.

Dezinstalati SmartControl Lite si
reinstalati-l.

Attention

Theft mode enabled

Mi-am uitat PIN-ul pentru functia Theft
Deterrence (Antifurt). Ce pot sa fac?

: Centrul de service Philips are dreptul

sa solicite un act de identitate si

0 autorizatie in scopul stabilirii
proprietarului monitorului.

Retineti cd functia antifurt este furnizata
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ca optiune gratuitd. Gestionarea
numerelor PIN este responsabilitatea
exclusivd a utilizatorului individual sau a
organizatiei care le seteazd.

Daca uitati numarul PIN, centrul de
service Philips 1l poate seta din nou
pentru dvs. contra unei taxe modice
dupa verificarea proprietdtii. Retineti ca
aceasta activitate nu este acoperita de
termenii garantiei standard.

8.3 Intrebari frecvente generale

1: Cand instalez monitorul, ce trebuie sa
fac daca se afiseaza ecranul ,,Cannot
display this video mode” (Acest mod
video nu poate fi afisat)?

Rasp.: Rezolutia recomandatd pentru acest

monitor: 1440 x 900 la 60 Hz

*  Deconectati toate cablurile, apoi conectati
PC-ul dvs. la monitorul pe care I-ati utilizat
anterior.

+ Tn meniul Start al Windows, selectati Settings
(Setari)/Control Panel (Panou de control).
In fereastra Control Panel (Panou de
control), selectati pictograma Display (Afisaj).
Tn Display Control Panel (Panou de control
afisaj), selectati fila , Settings” (Setéri). In fila
de setdri, in caseta cu eticheta ,,desktop
area’ (,,zond desktop'"), mutati bara laterald
la 1440 x 900 pixeli.

*  Deschideti ,,Advanced Properties”
(Proprietati complexe) si setati Refresh Rate
(Ratd de improspatare) la 60 Hz, apoi faceti
clic pe OK.

*  Reporniti computerul si repetati pasii 2 si
3 pentru a verifica dacd PC-ul este setat la
1440 x 900 la 60 Hz.

*  Opriti computerul, deconectati monitorul
vechi si reconectati monitorul LCD Philips.

*  Porniti monitorul si apoi porniti PC-ul.

12: Care este rata de improspatare
recomandata pentru monitorul LCD?

Rasp.: Rata de improspatare recomandatd
pentru monitoare LCD este de 60 Hz.
In caz de perturbdri pe ecran, o puteti
seta pana la 75 Hz pentru a vedea daca
perturbarea dispare.
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i3:

Rasp.:

Rasp.:

Rasp.:

Rasp.:

Ce sunt fisierele .inf si .icm de pe CD-
ROM? Cum instalez driverele (.inf si
.icm)?

Acestea sunt fisierele driverului pentru
monitor. Urmati instructiunile din
manualul de utilizare pentru a instala
driverele. Computerul dvs. vd poate
solicita drivere pentru monitor (fisierele
Jinfsi.icm) sau un disc cu drivere

atunci cand instalati pentru prima data
monitorul. Urmati instructiunile pentru a
introduce (CD-ROM fnsotitor) inclus Tn
acest pachet. Driverele pentru monitor
(fisierele .inf si .icm) vor fi instalate
automat.

Cum reglez rezolutia?

Placa video/driverul grafic si monitorul
determind impreuna rezolutiile
disponibile. Puteti selecta rezolutia doritd
din Control Panel (Panoul de control)
din Windows® cu ,,Display properties”
(,,Proprietati afisaj”).

Ce se intdmpla daca ma Tncurc atunci
cand reglez monitorul din meniul OSD?

: Apasati pe butonul OK apoi selectati

,Reset” (Resetare) pentru a reactiva
toate setdrile originale din fabrica.

Este ecranul LCD rezistent la
zgarieturi?

in general, se recomands ca suprafata
ecranului sd nu fie supusa socurilor
excesive si sd fie protejata Impotriva
obiectelor ascutite sau tdioase. Atunci
cand manipulati monitorul, asigurati-va
cd nu este aplicata fortd sau presiune pe
suprafata panoului. Acest lucru poate
afecta conditiile de garantie.

Cum trebuie sa curat suprafata panoului
LCD?

Pentru curdtare normald, folositi o carpd
curatd si moale. Pentru curatire extensiva,
folositi alcool izopropilic. Nu utilizati
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solventi precum alcoolul etilic, etanolul,
acetona, hexanul etc.

18: Pot sa schimb setarea culorii
monitorului meu?
Rasp.: Da, puteti sd schimbati setarea culorilor

prin comenzi OSD conform urmatoarei
proceduri.

Apasati pe ,,OK" pentru afisarea meniului

OSD (Afisare pe ecran)

Apasati pe ,,Down Arrow" (,,Sageata n

jos”) pentru a selecta optiunea ,,Color"

(,,Culoare”), apoi apasati pe ,,OK" pentru

a introduce cele trei setari de culoare

prezentate in continuare.

1. Color Temperature (Temperatura
culoare); cele doi setdri sunt 6500K si
9300K. Cu setdrile din intervalul 6500K,
imaginea pare caldd, cu o nuantd de
culoare rosu-alb, in timp ce temperatura
9300K reda o nuanta rece, albastru-alb.

2. sRGB; aceasta este o setare standard
pentru asigurarea schimbului corect de
culori intre diferite dispozitive (de ex.
camere digitale, monitoare, imprimante,
scanere etc.)

3. User Define (Definit de utilizator);
utilizatorul poate alege setarea de
culoare preferatd prin reglarea culorilor
rosu, verde si albastru.

& Noti:

O cuantificare a culorii luminii radiate de

un obiect n timp ce este incdlzit. Aceastd
cuantificare este exprimata pe scard absolutd,
(grade Kelvin). Temperaturi Kelvin mai mici
precum 2004K reprezintd rosul; temperaturi
mai mari precum 9300K reprezintd albastrul.
Temperatura neutrd este alb, la 6504K.

19: Pot conecta monitorul LCD la orice
PC, statie de lucru sau Mac?
Rasp.: Da.Toate monitoarele LCD Philips sunt

complet compatibile cu PC-urile, Mac-
urile si statiile de lucru standard. S-ar
putea sd aveti nevoie de un adaptor
de cablu pentru a conecta monitorul
la sistemul Mac.Vd recomanddm sd
contactati reprezentantul de vanzari
Philips pentru mai multe informatii.



8. Depanare si intrebari frecvente

i10:

Rasp.:

Rasp.:

Monitoarele LCD Philips sunt plug-and-
play?

Da, monitoarele sunt monitoare plug and
play, compatibile cu Windows 7/Vista/
XP/NT Mac OSX si Linux.

Ce inseamnd aderenta imaginii, arderea
imaginii, persistenta imaginii sau
imaginea fantoma la ecranele LCD?

Afisarea neintreruptd si indelungatd

a unor imagini statice poate cauza

o ,ardere” (,,persistentd a imaginii”’

sau ,,imagine fantomd”) pe ecran.
,Imaginea arsd”, ,imaginea persistentd”
sau ,imaginea fantoma” reprezintd un
fenomen binecunoscut in tehnologia
ecranelor LCD. In majoritatea cazurilor,
,imaginea arsd" sau , persistenta imaginii”
sau ,,imaginea fantoma” va disparea
treptat intr-o perioadd de timp dupa ce
alimentarea este oprita.

Activati Intotdeauna un economizor
ecran cu miscare cand lasati monitorul
nesupravegheat.

Activati intotdeauna o aplicatie periodica
de Tmprospdtare a ecranului atunci cand
monitorul LCD va afisa un continut
static.

) Avertisment

Simptomele grave de ,,ardere” sau ,persistenta a
imaginii”’ sau ,,imagine fantoma"” nu vor disparea
si nu pot fi reparate. Deteriorarea mentionata
mai sus nu este acoperitd de garantie.

12:

Rasp.:

De ce ecranul meu nu afiseaza text clar
si caracterele afisate nu sunt uniforme?

Monitorul functioneazd optim la rezolutia
nativa de 1440 x 900 @ 60Hz. Pentru
cea mai buna afisare, utilizati aceasta
rezolutie.
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